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Introduction 
The following release notes describe the significant new features that are 
available in V-STARS Version 4.2.  A more comprehensive description of the 
features described herein will be available in the new V-STARS Manual that will 
be released with the formal release of the software. 
 
The release notes also describe many of the software irregularities (bugs) that 
have been corrected since the previous release. (V-STARS 4.1 SR4.) 
 
Please keep in mind that this is Beta software and should be treated as such.  All 
care has been taken to ensure that the software is functional and operates as it 
should.  However, until is has been officially released, we advise you to continue 
using release software for critical jobs. 
 
This software has passed all our internal testing.  Although this testing is thorough 
it is by no means complete.  We cannot run through all the possible 
combinations and applications that our large and varied user base does.  We 
therefore urge you to try out the new features as much as you can in the next 
few weeks to confirm that they work properly.  Please notify us as soon as 
possible of any problems you find so they can be fixed in the formal release. 
 
As we are aiming for a formal release of the software in October 2000, we regret 
we will be unable to incorporate any more new features into this release.  If there 
are any new features you would like, please convey them to us 
(info@geodetic.com), and we will endeavor to incorporate them into a future 
release. 
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V-STARS S-Mode Features 
The following features are used in S-Mode measurements. 

Point SuperFind 
Description 
This feature allows new points to be measured in all images (in which they exist) 
by measuring them in a single image.  The point is measured in the current 
picture and then automatically in any other pictures that see the point.  The 
point is then automatically triangulated and added to the current driver file.  
SuperFind is especially useful for picking up occasional points that were not 
AutoMatched, or for re-measuring points that were inadvertently deleted.   For 
best results you should usually re-run the bundle after you have measured any 
new points with SuperFind. 
 
To complete the same process in Version 4.1 it would be necessary to measure 
the same point in at least two different pictures, triangulate the point, driveback 
to all the other pictures and then re-bundle with the new point/s.   
 
Conditions 
For SuperFind to work, you must have a good solution for the camera calibration, 
and a good resection solution for each picture.  Normally, you will use SuperFind 
after you have let the AutoMeasure process run to conclusion.  In this case, you 
will have a converged bundle solution so the conditions above will be met.  You 
can also use SuperFind after the AutoMatch portion of AutoMeasure is 
completed, but your success will depend on how good the camera and picture 
solutions are at that time.   
 
Implementation 
This feature is implemented in much the same way you globally relabel a point. 

 
1. Open the picture that has the point(s) that you wish to measure. 

2. Select the SuperFind cursor  from 
the measurement toolbar.  

3. The cursor will change to the shape of the SuperFind cursor.   
4. Type in the point label that you wish to assign to the new point.   
5. Move the point inside the measurement window. 
6. Click on the point. The point should now be marked with a cross and labeled.
7. Repeat steps 3-6 for any other points.  If there are other points you want to 

measure that are not in this picture, just close the current picture, and open 
those picture(s) one at a time and repeat steps 3-6. 

8. The 3D coordinates of the points will be automatically added to the current 
driver file.  For the highest accuracy you should re-run the bundle after all 
points are measured. 
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Trouble Shooting – Point not found. 
The point must be in at least three pictures for SuperFind to work.  If the point is 
not measured, the point will not be marked with a cross or relabeled.  Otherwise, 
the point will be added to the current driver file.   If you know the point is in at 
least three pictures, but is not measured, then the camera and/or picture 
solutions are probably not good enough to use SuperFind yet.  If this is the case it 
is advisable to run the bundle to get a better solution. 
 

Coded Target Nugget Measurement 
Description 
In V-STARS 4.2, the square targets in a coded target (called the “nuggets”) can 
be measured just like the central target.  This means that every time a code is 
seen, eight targets are measured. (Seven nuggets and one central point.) 
 
This is very useful when a picture cannot be automatically measured because it 
has less than four known coded targets.  By turning coded nuggets on, you can 
often automatically measure a picture that has only three (and sometimes only 
two) coded targets.  This capability also supports a new kind of target 
developed by GSI that can greatly automate the measurement of certain 
geometrical features.  These new targets are called Feature Targets, and they 
are described in Appendix A.   
 
NOTE: The images must be scanned/re-scanned in order for the nuggets to be 
measured. 
 
Implementation 
1. To switch on the coded 

targets nuggets open 
the Advanced Edit 
dialog Project –> 
Advanced Edit) and 
click on the Coded 
Target button.  The 
dialog box shown here 
will appear. 

2. Check the Target 
Nuggets box.   

3. Run AutoMeasure and 
press the Start button.  
This is necessary to re-
scan the images to find 
the code nuggets.   
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Considerations 
Although measuring the coded target nuggets can be a handy way to 
automatically measure a picture, there are a few things that need to be 
considered.  In cases where only one or two codes are seen in a picture, the 
picture solution will be very weak and may fail.  If it fails, you will have to measure 
the picture manually if you want to use it.  Even if it passes, be aware that the 
weak picture solution may cause problems later on.  Measuring the code 
nuggets are meant to help you out of tight spots and are not a substitute for 
good planning and preparation. 

Enable/Disable Scale Bars 
Description 
Scale bars can be enabled or disabled from within V-STARS.  In previous versions 
it would be necessary to delete the scale bar or change one of the point labels 
to disable the bar. 
 
Implementation 
Scale bars are enabled or disabled in a similar manner to 
pictures.  You can enable or disable an individual bar by 
doing the following: 
 

1. Hover over the scale bar you wish to enable/disable 
and right click. 

2. Select Enabled to change the status of the bar. 
 
 

You can also enable or disable multiple bars by doing the following: 
 
1. Right click on the scale bars icon, and select Enabled. 
2. Multi-select the bars whose status you wish to change. 
3. Press the OK button. 
 

Disabled scale bars will be displayed with a disabled icon.  
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Picture Contrast Control 
Description 
It is now possible to adjust the picture contrast without having 
to right click and select the contrast.  This is shown in the 
adjacent image. 
 
Implementation 

1. Open an image 
2. Hold down the CTRL key while using the left and right 

arrows to change the contrast.   

Zoom Data Window Stays Open 
Description 
In previous versions of V-STARS the Zoom Data window shown 
below would close automatically when the picture was 
closed.  This meant that the window had to be re-opened in the next picture.  In 
V-STARS 4.2 the window will remain open until closed by the user.   
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New, More Accurate Centroiding Algorithm Used 
Description 
The accuracy of the target centroiding algorithm has been improved.  The new 
algorithm is also less sensitive to the background of the target.   It is 
recommended that this new algorithm be used.  The new algorithm is 
automatically enabled during the 4.2 installation.  If you want to disable it, do the 
following: 
 

1. Open the global GSI32.INI file.  On NT and 2000 machines this should be in 
the WINNT directory.  On WINDOWS95/98 machines this should be in the 
WINDOWS directory.   

2. Change the entry in the [scan] section 
new centroiding=true to  
new centroiding=false.  Case does not matter. 

3. Close the file.  The old algorithm will be used on all future projects. 
4. To enable the new centroiding set the option to TRUE. 
 
NOTE: The old algorithm will be used for versions prior to 4.2 no matter what 
the setting of the “new centroiding” variable. 

Target Filters Added 
Description 
New target filters that are very effective in removing false targets have been 
added.   This, in turn makes AutoMatching faster and more reliable.  In some 
cases, they will remove legitimate 
targets.  If so, this is generally because 
those targets are of poor quality and 
will be rejected in the Bundle 
adjustment anyway.  One filter 
removes targets whose shape is 
unacceptable (Shape Filter); the other 
filters out targets that are too dim 
(Brightness Filter).   
 
Implementation 
The target filters are automatically 
enabled during the 4.2 installation.  To 
disable them, do the following: 

1. Open the Advanced Edit 
dialog box by selecting Project-
>Advanced Edit. 

2. Click on the General button in 
the Setup area of the dialog 
box. 

3. Click on the Target Criteria tab. 
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4. In the Target Criteria dialog box, uncheck the Shape checkbox to turn off 
the shape filter.   

5. Uncheck the Brightness checkbox to turn off the brightness filter. 
 

NOTE: An easy way to check which targets are removed by these filters is to 
select Target Search under the Command menu.  This will scan a picture for 
targets without using these new filters.  Then if you AutoStart or SuperStart a 
picture in the usual manner you will see only targets that have passed the filters.  
 
NOTE:  If you are using the PRO-SPOT target projector, these filters may remove 
legitimate projected targets depending on the quality of the surface.  If you 
want to measure all possible projected points turn off these filters. 

AutoMatching Improved 
Description 
 AutoMatching is faster and more reliable.  Users should notice speed 
improvements and fewer missed points.  Also, you can choose a new, more 
rigorous mode of AutoMatching that is more reliable, but in some cases slower, 
especially for large data sets (>~20 pictures).   
 
Implementation 
 To select the new rigorous mode, select Project-> AutoMatch-> Setup, and click 
on the rigorous check box.   
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Support for New PRO-SPOT Projector Added 
Description 
Some new features have been added for GSI’s new PRO-SPOT target projector.   
No special adjustments to the software are needed when a measurement has a 
single setup of the projector.  However, when doing a PRO-SPOT measurement 
with multiple projector setups, (for example to increase the density of points or to 
measure a larger area than can be covered in one setup), some software 
adjustments are needed.   
 
The standard procedure when doing a multiple projector setup measurement is 
to store the pictures for each setup in a separate Job directory on the INCA 
camera’s disk.   Then, V-STARS can be setup to treat each Job’s pictures as a 
separate AutoMatch set and therefore eliminate any confusion about projected 
points that are very close together.   
 
Implementation 
There are two selections that must be made 
to use PRO-SPOT with multiple setups.  First, 
instead of selecting a single job directory 
containing the pictures for the project, as is 
normally the case, you must select all the 
Job directories used for the different setups.  
An example of this is shown below where 
Jobs 2, 3 and 4 are selected for the project 
(Job1 has another project’s pictures).  
Second, you must tell V-STARS to separate 
the Jobs into separate groups for 
AutoMatching.  
 
You do this by selecting Project->AutoMatch->Setup and checking the Separate 
Multiple Jobs checkbox.  Then, AutoMatching will not match targets across jobs. 
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Bundle Changes 
Description 
The main Bundle dialog box has changed to incorporate some new buttons and 
features.  The new Bundle dialog is shown below. 
 

 

New Buttons Added 
Description 
Setup and Save Info buttons have been added to the Bundle dialog box.   
 
Implementation 
The Setup button will take the user directly to the Bundle Setup dialog.  In 
previous versions the user had to exit the Bundle to make changes to the setup. 
 
The Save Info button will save the bundle summary dialog’s information into a 
text file.  This is particularly useful if the user wishes to review the Bundle Summary 
at a later date or include the summary in a report.   
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A typical Bundle summary is shown below: 
 
Bundle Dialog Information

Status: Bundle Converged after 2 Iterations
Current Point:
Rejection Limit: 0.86um
Residual RMS:

0: 0.22um
1: 0.22um
2: 0.22um

Pictures

Total: 19
Weak: 0
Bad: 0

Points

Total: 175
Weak: 0
Bad: 0
Two Ray: 0

Scales

Total: 0
Weak: 0
Bad: 0
RMS: N/A

Control Points

Control Points: N/A

Accuracy

RMS:
X: 0.019
Y: 0.008
Z: 0.009

Max:
X: 0.039
Y: 0.014
Z: 0.017

Points over limit: 0
Plan Quality Factor: 1.05
RMS of Measurements: 0.22um

 

Bundle Sub-sampling Improved 
 
Description  
This feature has been enhanced and is very useful for jobs with large numbers of 
points (such as PRO-SPOT projects).  Sub-sampling can greatly reduce the time 
for processing the data while having insignificant effects on accuracy (if used 
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properly).  To understand what sub-sampling does, a brief explanation of the 
bundle processing is warranted.  In the first step of the processing, the bundle 
adjustment iteratively solves for the camera calibration and the picture solutions.  
Then, with this information available, all the points are triangulated to produce 
their final 3D coordinates.  In the past, all the available points were used in the 
time-consuming bundle adjustment portion.  Now, by a judicious selection of a 
subset of the points, the user can greatly improve the speed of the processing 
while not significantly affecting accuracy.  The time for the bundle adjustment is 
proportional to the number of points, so if you sub-sample 200 points of a 1000 
point measurement, the bundle will run 5 times faster. 
 
Implementation  
Sub-sampling is selected via the Bundle Setup dialog box which can be reached 
from the main menu or now directly from the Bundle Main Dialog.  The new 
dialog box appears as follows.  The main difference is that the Sub-Sample 
section has been added.   

 
 
NOTE:  Coded targets (and their nuggets, if enabled), and control points are 
always included in the bundle adjustment.  They cannot be sub-sampled. 
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There are four main Sub-Sampling options as described below.   
1) None – when selected the Sub-Sampling will be disabled.  In this mode all 

the input areas are grayed out.  All points will be used in the bundle 
adjustment.   

2) Percent - The Percent option will use the specified percentage of the total 
number of sub-samplable points.  This percentage is set in the Number 
input box.   

3) Fixed – The Fixed option will use a fixed number of the total sub-samplable 
points.  The number of points is set in the Number input box.   

4) Skip – The Skip option will select every nth sub-samplable point as it is 
encountered.  Once again n is defined in the Number input box.   

 
NOTE:  By default the number input box is set 
to –1.  Please enter an appropriate number 
once you have decided on the type of sub-
sampling you wish to do.  
 
NOTE:  In sub-sampling, the software selects 
the points from the set of sub-samplable points by selecting every nth point in the 
measurement (points are ordered alphanumerically by label); n is determined by 
the sub-sampling option chosen above. 
 
If a sub-sampling option is selected, additional options are available.  These are: 
 
Triangulate Only or Re-Bundle - When the bundle solution 
using the sub-sampled set of points is complete, you 
have two choices.  You can select Triangulate Only to 
use that solution to triangulate all the points.  Or, by 
selecting ReBundle with All, you can automatically re-run 
the bundle adjustment using all the points and use that solution to triangulate all 
the points.  The first choice is faster; the second choice is more accurate 
(however, the accuracy improvement should be negligible if you have selected 
a good sub-sample set; see Note below).   
 
AutoMatch Only Checkbox – When checked, only AutoMatched points will be 
sub-sampled.  AutoMatched points begin with the prefix TARGET.  All other points 
will be included in the bundle adjustment.  When unchecked, all points (except 
codes, nuggets, and control, see above) will be sub-sampled.   
 
Include Points 
Checkbox - The 
include points option 
will include in the 
bundle any of the 
points that are listed in the adjacent text box.  The text box supports the "*" and 
"?" wildcards.  Multiple strings can be entered; a space or a comma must 
separate them; case does not matter.  A range of points can be specified by 
separating them with the ">" symbol (i.e.  “line1 > line120” would include all points 
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with labels from line1 to line120 inclusive); spaces are allowed between the > 
symbol and the two labels.   

 
NOTE: Users should be careful when sub-sampling.  Make sure there are still 
enough points in the bundle adjustment to get a good solution.  This means you 
should have at least 20 well-distributed points (preferably 40) in each picture, 
and at least 50 well-distributed points (preferably 100) total.  When in doubt 
about the number of points or whether they are well distributed, include more 
points.  Also, make sure that any tie and/or fill points you have used for the 
measurement are included in the sub-sampled data set.   
 

Bundle Automatic Scale Rejection Added 
 
The bundle now can automatically reject scale bars based on criteria defined in 
the GSI32.ini file.  Criteria are provided for rejecting scale bars with deviations 
that are large relative to the other scale bars (as defined by the RMS of their 
deviations), or larger than a fixed value.   
 
By default this feature is disabled (-1).  The following lines in the GSI32.ini file 
control the scale bar rejection. 
 
scalebar rejection factor=-1 < 0 :  Relative scale bar rejection disabled. 

> 0 : Multiply RMS of all scale bars by this 
factor to get the rejection limit. 
 

scalebar rejection value=-1 < 0: Absolute scale bar rejection disabled.  
> 0: Any scale bar deviation with an 
absolute value greater than this value is 
rejected.   
NOTE: The units for this value are defined by 
the “accuracy units” variable in the 
GSI32.INI file. 
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RSS Accuracy Estimate Added 
 
The RSS accuracy estimate is now added to the bundle points summary.  RSS 
stands for square Root of the Sum of Squares.  The formula for the RSS accuracy 
of a point is: 

RSS = (Xaccuracy2 + Yaccuracy2 + Zaccuracy2 )½ 

. 

The RSS is a useful statistic that combines together the separate coordinate 
accuracy estimates into one meaningful quantity.  It represents the accuracy 
estimate of the distance of the measured point from its true value. 
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Bundle Can Be Continued After Stopping 
 
The bundle adjustment can now be continued after it is stopped.  In the past if 
the user pressed the Stop button there was no way to restart the bundle.  (Also, 
to make inadvertently pressing the Stop button less likely, it has been relocated.) 
There are now options to re-start the bundle.  When stopped the dialog buttons 
will change as shown in the dialog below.   
 

 
 
Press Continue? to continue from where the bundle stopped, or Stop? to stop the 

bundle.  If Stop? Is pressed again the following dialog appears.   

 
Press Yes to stop the bundle and revert to its original starting values.  Press No to 
continue the Bundle process. 
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New 3D Viewer and Solids Features 
New Alignment Options 
Description 
V-STARS 4.2 now has enhanced alignment features.  
The new Alignment options are shown in the 
adjacent image.  They are:  

1. You can now view the residuals after an 
alignment in Quick or Standard form.  In 
Standard form, residuals for points that were 
not included in the alignment are bracketed, 
and are not included in the RMS calculations.  

2. The File alignment allows the user to perform 
a transformation using a transformation file 
that is in a compatible third party package’s 
format.  Currently, file transformation formats 
from CATS and Holos are supported. 

3. The Manual alignment can be used to 
manually shift, rotate or scale a 3D file into a new position.   

 
Implementation – Residuals Quick/Standard 
Selecting the Residuals – Quick option will display the usual residuals dialog.  
However, selecting the Residuals – Standard will display a dialog similar to the 
one below.  The dialog has brackets around any residuals that were not included 
in the standard transformation (due to their sigmas not being fixed).  Also, the 
statistics at the bottom of the display will not include any bracketed values in 
their calculation. 
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Another new feature is that the transformation can be re-computed by typing in 
a new rejection value and pressing the Apply button.  The results of the 
transformation can also be saved using the Save 
button. 
 
Implementation – File 
Selecting the File option will display the following 
dialog.  Browse to select the file that contains the 
pre-defined values.  Press OK to implement the 
transformation.   Currently, transformation files 
from CATS, HOLOS, and GSI are supported. 
 
 
Implementation – Manual Alignment 

1. Select the 3D file that needs to be manually 
aligned. 

2. Right click and select the Manual option.  
The following dialog will display.  You can 
shift the data in each of the three 
coordinate axes; you can rotate around each of the three axes, and you 
can change the scale. 

3. To shift the data in X, Y or Z, type the shift 
values in the boxes and press the Begin 
button.  The value in the boxes will be 
added to every point in the file.   

4. To rotate the data around the X, Y, or Z 
axis, enter the rotation value in the 
appropriate box, and press the Begin 
button.  You may only rotate around 
one axis at a time.  A positive value 
rotates counter-clockwise around the 
axis as viewed down the positive axis. 

5. To scale the data enter a value in the 
scale box and press Begin.  Every point 
coordinate will be multiplied by the 
scale value. 

 
NOTE:  The Undo button will only undo the most recent alignment.   
 

Solids Certified by PTB 
Description 
Solids has now be officially certified by PTB (Physikalisch-Technische 
Bundesanstalt).  The PTB is the German equivalent of NIST, and tested the 
geometric algorithms of Solids against standard data sets.  For a copy of the 
certification please contact GSI. 
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Direct Export of Planes, Lines, Circles and Spheres 
Description 
Solids can now directly export the results of plane, line, circle and sphere 
calculations directly to a text file. 
 
Implementation 

1. Highlight the object 
you wish to export.  
Only one object type 
can be exported at a 
time. 

2. Right click over the 
objects and select 
Export.  Select Text or 
Tabbed Text. 

3. Enter a file name and 
press Save. 

 

IGES Functions Are Improved 
Description 
The IGES reading function has now been improved so that trimmed surfaces are 
read correctly. 
 
You can also use Wildcards (*) when specifying surfaces.  This means that a point 
or points can be projected or measured to any number of surfaces.  For example 
SURF* is the notation for any surface that starts with the text "SURF". 

More Graphical Hot Keys Added 
Description 
There are now some new hot keys that make V-STARS faster and easier.  The 
following keys have been added: 
 
Command Hotkey Note 
Enable / Disable Picture Stations Ctrl + E Select the Stations first 
Resect Selected Picture Stations Ctrl + R Select the Stations first 
Display stroke Inc / Dec Ctrl + 7 / 8 V-SURF feature only 
Display resolution Inc / Dec Ctrl + 9 / 0 V-SURF feature only 
Enable / Disable selected surfaces Ctrl + F1 V-SURF feature only 
Enable all surfaces Shift + Ctrl + F1 V-SURF feature only 
Display resolution Inc / Dec Ctrl + 2 / 1 Curve Analysis 
Display View Setup ~ Display the 3D view setup 
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Other New Features 
Faster Point Listing 
Description 
Point listing is now practically instantaneous.  You will no longer have to wait for 
points to fill in a list. 
 

Tools Menu Now Customizable 
Description 
It is now possible to add programs to the tools menu.  This means that users can 
call programs such as Word, Excel or Explorer directly from V-STARS.  
 
Implementation 

1. Select the Customize option from the Tools Menu. 
2. Press the Add button to add a new tool. 
3. Browse to the appropriate executable using the "…" 

button. 
4. Enter any relevant arguments. 
5. Select the initial directory for any data using the ”…” 

button.  If you want the command to use the 
current project directory as the initial directory, 
leave this field blank. 

6. Press OK to accept the tool. 
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Move Data From Design to Measured 
Description 
Occasionally it is desirable to move design data into measured data.  In previous 
versions this was tedious as the points had to be copied and then pasted into a 
new file.  V-STARS 4.2 can now directly move the 
data. 
 
Implementation 

1. Open the design folder that contains the 
data. 

2. Right click on the points icon 
3. Select Move to Measured.  

 

Zipping a Project 
Description 
You can now easily compress (zip) all project data.  This is accomplished using 
PKZIP.  The compressed project is a .zip file that is given the name "project 
name.zip".  You have two choices; you can save all data, or all data except the 
image files (*.gsi files).  This feature is useful for saving a completed project in a 
compressed format that saves space.  However, its main use is to allow users to 
easily zip up the state of a project when a problem or bug is found.  Then, you 
can send the zip file to GSI for analysis.  We urge customers to use this feature.  
Often, as you work around or through a problem, you end up changing the state 
of the project, and we can no longer reproduce the problem.  It will help us 
tremendously in finding and diagnosing problems if you use this command 
immediately after finding a problem.  
 
Implementation 
To save a project, select either Zip Project – No Images or 
Zip Project – With Images from the Tools menu.  A DOS 
window will be displayed showing the progress of the ZIP 
operation. We recommend you not do anything else 
while the ZIP operation is running. When it is done, the 
DOS window will disappear, and the data you selected 
will be saved in a file in the project directory.  The file’s 
name will match the name of the project and will have 
the name "project name.zip".  
 
NOTE: The Zip Project – With Images command will only zip the .gsi files if they are 
in the project directory, or a subdirectory of the project directory.   
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Export to Third Party Packages Increased 
Description 
You can now export measurement data to the analysis packages from 
Metrologic’s Metrolog package, and DelCam’s Power Inspect package. 
 
Implementation 
To export data to either analysis 
package, do the allowing: 

1. Right-click on the 3D file 
containing the measurement 
data, and select Export from 
the menu.   

2. Select the package you wish 
to export to.  A dialog box will 
appear listing a default name 
for the file that will contain the 
exported data. 

3. When the file name is 
acceptable, press the OK 
button. 

 
 

Merge 3D files 
Description 
You can now merge several 3D files into a single 3D file.  Points with the same 
label are averaged, and the average values of the points are written to the 
merged file.   
 
Implementation 
To merge a number of files, do the following:  

1. Click on the 3D file icon.  The names of all the 3D 
files in the project will appear in the right pane of 
the window. 

2. Select the files you want to merge.  The selected 
files will be highlighted. 

3. Right click and select Merge from the menu. If 
Merge is grayed out, you have not selected at 
least two 3D files. 

4. A dialog box will appear.  Enter the name of the 
merged data file in the field.  

5. Press the OK button. The 3D file with the merged 
data will be saved in the current project. 

 
NOTE: Ensure data is in the same coordinate system prior to merging.  Merging 
unaligned data sets will produce unpredictable results. 
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V-STARS/M Mode Features 
 
The following features are used in M-mode measurements.   

M-Mode Setup 
 

 
 

It is now possible to edit the M-Mode parameters.  The Setup dialog is located on 
the MMode menu.  The following options are available. 
 
Triangulate 
Write new or detail points to a Triangulation file. 
 
Overwrite Triangulation 
Overwrite the triangulation file.  If this option is unchecked a new triangulation 
file will be created each time. 
 
Triangulate All 
Any points in the detail file and driver file will be triangulated. 
 
AutoMatch  
A two station AutoMatch will be run.  Keep in mind that this is only based on two 
images and therefore may not be as reliable as normal AutoMatching. 
 
Overwrite AutoMatch 
The AutoMatch file is overwritten after each epoch. 
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Construction Bar Improved 
There have been several improvements when using the construction bar.  These 
include: 

1. You can now change the number of points to probe while probing. 
2. You can undo the most recent measurement(s) one at a time,  
3. Audible indications are given for various conditions such as feature 

created, point missed or feature rejected. 
 

 
Four new features have also been added.  They are the create plane, create 
line, create circle and create sphere constructors. 
 
Plane  
Use this feature to create a plane.  The last point collected is used to define the 
compensation direction and should be off the plane surface in the direction of 
the cameras.  For example in the case below a total of five points were 
collected.  Four of these were on the plane surface.  The last point was off the 
surface.  The plane created was offset by the radius of the ball tip in the direction 
away from the compensation point. 
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Line 
Use this feature to create a best-fit line.  Once the data is collected the system 
will beep twice and the acquired line created. 
 

 
 
Circle 
Use this feature to create a best-fit circle and center (optional).   
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Sphere 
Use this feature to create a best-fit sphere and center point (optional).   
 

 
 

Support for Coded Target Offset Rods Added 
 
Description 
Our newly developed Coded Target Offset Rods can be used 
instead of the hand-held probes to measure untargeted points 
or features.  Any practical number can be used at the same 
time.  They are especially useful for the real-time building of 
parts.  In this application, several are typically attached to the 
part being built, and they are automatically measured by V-
STARS no matter where they are located so long as both 
cameras see the code.  They also have the characteristics of 
Feature Targets (refer to Appendix A) in that they are used to 
derive the locations of points that are related in some way to 
the feature being measured. 
 
Implementation 
 
We will be providing an application note in the future on the 
use of Coded Target Offset Rods. 
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V-STARS Bug Fixes 
 
The following bugs have been fixed in V-STARS 4.1 
 
• Zero length scale bars no longer allowed (ignored). 
• V-STARS no longer drives back to construction points. 
• Scale bar labels now visible in graphical view. 
• Best-fit circle, sphere now works when center or radius is held fixed.  
• Construction objects now update properly. 
• Arrow keys now functional in the graphical view while in rename mode.  
• When opening a project, if any file project files are read only, the user is 
warned that any changes made to the file will not be saved.  Additionally, 
deleting read only files from the project is not permitted and the user is warned 
when attempting to do so. 
• V-STARS no longer crashes in print preview if the program is closed.  
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